UNIVERSAL DESIGN & ACCESSIBILITY IN WORD WORKSHOP
ONE HOUR INSTRUCTION + 30 MINUTE WORKSHOP

Office of Online Learning
Nashville State Community College
ww2.nscc.edu/onlinelearning/
This hour-long session will share and demonstrate best practices for creating accessible content as part of the TBR Accessibility Initiative on the NSCC campus. It will provide context for accessibility initiatives by briefly examining the evolution of accessibility in higher education, and will provide practical guidance and instruction for creating accessible content in Microsoft Word and HTML for on-ground, hybrid, and online courses.

Bring a course document and stay for a half-hour hands-on workshop after the session where you can implement the accessibility skills you’ve learned.
Table of Contents
Accessibility Introduction ........................................................................................................... 4
  Legislation .............................................................................................................................. 4
Accessibility at NSCC .................................................................................................................. 6
  What is Accessibility? .............................................................................................................. 6
  What is Accommodation? ........................................................................................................ 6
  What is the Difference? ............................................................................................................ 6
  What does this mean for me? .................................................................................................. 6
Accessibility Criteria .................................................................................................................. 7
Tutorials ..................................................................................................................................... 8
  Make sure content is clearly written and easy to read .......................................................... 9
    Choosing a font ..................................................................................................................... 9
    Ensuring sufficient contrast ................................................................................................. 9
    Creating a clear, simple, and consistent design ................................................................. 10
Provide appropriate document structure .................................................................................. 11
  Headings ............................................................................................................................. 11
  Lists ..................................................................................................................................... 12
Ensure links make sense out of context .................................................................................... 13
  Creating hyperlinks .............................................................................................................. 13
Provide appropriate alternative text ......................................................................................... 14
Do not rely on color alone to convey meaning ........................................................................ 16
Create accessible data tables .................................................................................................. 18
Run Accessibility Checker ........................................................................................................ 21
Updating Old Microsoft Word Documents for Accessibility .................................................. 23
  Step 1: Planning ................................................................................................................... 23
  Step 2: Open Your Old Document ......................................................................................... 23
  Step 3: Start a New Document .............................................................................................. 23
  Step 4: Save your New Document ......................................................................................... 23
  Step 5: Style your Document ............................................................................................... 24
    Using the Styles Ribbon ..................................................................................................... 24
  Step Six: Run the Accessibility Checker .............................................................................. 25
Other Resources: ..................................................................................................................... 25
Accessibility Introduction

It is estimated that up to 4% of the population relies on some sort of Assistive Technology to access electronic documents and Web pages. Assistive Technology includes Screen Reading software, Refreshable Braille displays, and Screen Magnifiers. In the United States alone that equals 12.5 million people. If electronic documents are not created with accessibility issues in mind, they become very difficult if not impossible to read or navigate for this large number of people. i

Accessibility to electronic documents is a right that is protected by both Federal and State law. Creating accessible electronic documents is important to ensure access to persons with disabilities and the company or agency is protected against legal action. Additionally, it is just good practice, when a very large segment of the population can equally participate and take advantage of the products or services that the company or agency provides. ii

While course content should be designed with accessibility principles in mind, it is best for the focus to be on universal design: courses and course content should be usable by people with the widest possible range of abilities, operating within the widest possible range of situations. This is about making things accessible to all people (whether they have a disability or not).

Universal design in instruction addresses the need to create flexible goals, methods, materials, and assessments that accommodate learner differences. As we incorporate universally designed instructional practices, we help all students succeed while transparently providing the required accommodation for students with disabilities. iii

Legislation

The Americans with Disabilities Act of 1990:
The ADA is a civil rights legislation that prohibits discrimination and ensures equal opportunity for persons with disabilities in employment, state and local government services, public accommodations, commercial facilities, and transportation. There are some provisions of the ADA that directly affect higher education. Title II applies to public universities and Title III applies to private universities iv. The ADA clearly states that communications with persons with disabilities must be “as effective as communications with others.” The Office of Civil Rights has defined this effectiveness to include three components:

- Timeliness of delivery
- Accuracy of the translation
- Provision in a manner and medium appropriate to the significance of the message and the abilities of the individual with the disability

Section 504 of the Rehabilitation Act of 1973:
This legislation is applicable to all universities that receive federal funding. It states: “No otherwise qualified individual with a disability in the United States . . . shall, solely by reason of
her or his disability, be excluded from participation in, be denied the benefits of, or be subjected to discrimination under any program or activity receiving Federal financial assistance.”

Section 508:
In 1998, Section 508 was added to the Rehabilitation Act to require Federal agencies to make their electronic and information technology (EIT) accessible to people with disabilities and requires that Federal agencies' electronic and information technology is accessible to people with disabilities. While Section 508 does not directly apply to NSCC, it provides technical standards for accessibility.


Accessibility at NSCC

What is Accessibility?
“Accessible” means that individuals with disabilities are able to independently acquire the same information, engage in the same interactions, and enjoy the same services within the same time frame as individuals without disabilities, with substantially equivalent ease of use. A few examples of accessibility are accessible web pages, accessible instructional materials, accessible apps and an accessible eReader.

What is Accommodation?
“Accommodations” are reasonable academic adjustments or auxiliary aids that provide equal access to programs and services on an individual basis. A few examples of reasonable academic adjustments or auxiliary aids are extended time on tests, taking an exam in a minimal distraction area, recording a lecture, and having a note-taker.

What is the Difference?
Accessibility is achieved through the use of identified standards to design environments to be used by everyone, including persons with disabilities, and oversight is often provided by an accessibility manager and/or ADA coordinator.

Accommodations are requested by a person with a disability and determined to be reasonable on an individual basis by an appointed representative, often, in a disability services office. Accommodations may be needed beyond an accessible environment for equal access to programs and services because of the individual nature of the disability not due to an environment’s inaccessible design.

It might be helpful to remember: “Accessibility is for everyone; accommodation is for an individual.”

What does this mean for me?
In accordance with the Americans with Disabilities Act, Nashville State Community College makes every effort to provide students with disabilities access to online learning programs offered by the College. Since the Internet often serves as a key to accessing these programs, it is vital that the Web course content be accessible for all users.

Thus, this law mandates that all instructional materials be accessible. The TBR Higher Education Accessibility Task Force has specified that “instructional materials” are items that are created, purchased, or identified to serve in instruction and communication of information in the curricular settings at public higher education institutions in Tennessee. These items may include, but are not limited to, texts in bound, unbound, kit or package form, library media (print, non-print, and electronic resource), instructional software content, web/online content and learning objects, E-books, CD-ROM, DVDs, videos, slides, films and filmstrips, learning laboratories, recordings, manipulatives, consumables and ITV content.
Accessibility Criteria

Tennessee House Bill 1857 (Senate Bill 1692) established the need for minimum accessibility criteria for informational materials and related technology used by institutions of higher education. To adhere to the minimum Web Content Accessibility Guideline 2.0 A & AA recommendations provided by the Tennessee Board of Regents to the Tennessee Higher Education Commission, the following criteria must be met:

Make sure content is clearly written and easy to read
There are many ways to make your content easier to understand. Write clearly, use clear fonts, and use headings and lists appropriately.

Provide appropriate document structure
Headings, lists, and other structural elements provide meaning and structure to web pages. They can also facilitate keyboard navigation within the page.

Ensure links make sense out of context
Every link should make sense if the link text is read by itself. Screen reader users may choose to read only the links on a web page. Certain phrases like “click here” and “more” must be avoided.

Provide appropriate alternative text
Alternative text provides access to non-tent content (such as images) in web pages. It is especially helpful for people who are blind and rely on a screen reader to have the content of a website read to them.

Do not rely on color alone to convey meaning
The use of color can enhance comprehension, but do not use color alone to convey information. That information may not be available to a person who is colorblind and will be unavailable to screen reader users.

Create accessible data tables
Tables should be used to organize data, not layout, and should use either the “scope” or “header and id” attributes for easier navigation with assistive technology.
Tutorials

As we learn how to meet each one of these accessibility guidelines, there are two principles to keep in mind:

- The skills that we learn in Microsoft Word in this workshop are transferable across authoring platforms. This means that these functions operate identically or very similarly in other Microsoft Office programs (PowerPoint, Excel), Adobe Acrobat, and D2L’s built-in HTML editor.
- Adhering to accessibility guidelines as part of a Universal Design approach to course content benefits all students—those with documented disabilities, those with undocumented disabilities, as well as those with no disabilities at all.
Make sure content is clearly written and easy to read

When creating accessible content, the first step is to plan the layout and content of your document before you begin. The more time you invest in planning, the less time you’ll have to spend fixing the document later. When planning your document, you might want to consider: how will the document look? What is the simplest and most logical way to convey this information?

Choosing a font

The font size used in a document can be difficult for users with visual, print, and cognitive disabilities to read. Sans serif fonts such as Arial and Verdana may be easier to read for some users. Additionally, for optimum accessibility, font size should remain at least 12 points.

In Microsoft Word, open a new document, select the HOME tab, navigate to the “Font” section of the ribbon, and select your font size and style.

Ensuring sufficient contrast

To ensure maximum readability by the largest audience, your document must use sufficiently contrasting foreground and background colors. Text should have a minimum contrast ratio of at least 4.5:1. While a white background with black text (or vice versa) is always compliant, other color combinations may not provide a sufficient contrast ratio to adhere to Web Content Accessibility Guideline (WCAG) 2.0 A &AA recommendations provided by the Tennessee Board of Regents.

When selecting foreground and background colors in Microsoft Word, use the Text Highlight Color and Font Color tools:

In order to ensure that your color selections are compliant (if selecting foreground/background colors other than black/white), utilize one of the following resources:

Snook Color Contrast Check
RGBtoHEX.net
**Universal Design:** using high contrast foreground/background colors benefits those with visual impairments, but most other users will also enjoy reading your content without squinting or experiencing eye fatigue.

**Creating a clear, simple, and consistent design**

When planning and creating your course content, avoid these formatting tools that create inaccessible content:

- Text box
- WordArt/SmartArt
- Shapes
- Drop Caps

**Universal Design:** providing a clear, simple, and consistent design benefits a variety of users with disabilities, but the result of doing so is a document where users can easily and efficiently find the information they’re looking for. Clearly, this is a benefit to all users.

When creating a multi-page document, instead of hitting the enter key, multiple times to move to the next page, navigate to the Insert tab, then click “Page Break” in the pages panel:
Provide appropriate document structure

Using Headings
Good heading structure helps readers to understand how the document is organized. Assistive technology users can move between headings, which makes navigation usable and more efficient than without headings. Headings and subheadings should be identified as such using the built-in heading features of the authoring tool. Headings should form an outline of the page and be used in the table of contents (TOC) for long documents:

Heading 1 for the main heading,

  Sub-Heading 2

  Sub-Heading 2

    Sub-Heading 3

If you find yourself needing to use more than three levels of headings, you may want to revisit chunking the content for easier readability.

To use headings in Microsoft Word, you should use the built-in Heading styles (“Heading 1,” “Heading 2,” “Heading 3,” etc.) available under Styles in the Home tab:

Editing Headers
To edit the properties of your built-in Heading styles, right-click on your desired heading in the Styles ribbon, and select “Modify…”

![Edit Heading in Microsoft Word]
Selecting “Modify…” will prompt the “Modify Style” dialog box. In this box, make the desired changes and modification to the font. Remember that changes to your heading using the “Modify Style” dialog box will change the style for the heading throughout your entire document:

Before clicking “OK,” verify that the “Add to the Styles gallery” and “Automatically update” checkboxes are both marked.

Lists
Any content that is organized as a list should be created using the list controls that are provided. Document authoring tools usually have one or more controls for adding lists. Using the available tools to create lists helps assistive technologies understand how the content is organized. Also, when screen reader navigates a list, the screen reader informs the user that they’re on a list and informs them of how many items are in the list. Not using the list tool (for example, simply using hyphens “-” or asterisks “*”) can make content more difficult to navigate and understand using assistive technology.

To include accessible lists in your course content using Microsoft Word, select either the Bullets, Numbering, or Multilevel List options from the Paragraph portion of the Home tab:
Unordered lists (bullet points) should be used when there is no specific order intended for the list you are creating.

Ordered lists (numbers, letters) should be used when there is a defined sequence or order intended for the list.

**Bold, Italics, Underline**

It is important to note that using font size, CAPITALIZATION, **bold**, *italics*, or *underline* to indicate emphasis is inaccessible to a screen reader. While you may want to use these strategies to indicate emphasis in your document, you must also indicate this emphasis in an accessible way:

1. Use asterisks before notable information: *important*
2. Use the Styles Ribbon:
   a. First, select the dropdown arrow:

   ![Styles Ribbon](image)

   The heading options for Subtle Emphasis, Emphasis, Intense Emphasis, and Strong all indicate emphasis that is accessible and recognizable by a screen reader.

**Ensure links make sense out of context**

**Creating hyperlinks**

Meaningful link text should not be overly general and should clearly describe the content to be found or action performed at the destination. Specifically, this should occur directly in the link
text making the link's purpose understandable when taken out of context. For example, do not use "click here." Not only is this phrase device-dependent (it implies a pointing device), but also it conveys nothing about what is to be found if the link is followed. Instead of "click here," link text should indicate the nature of the link target, as in "more information about sea lions" or "text-only version of this page." Many users of screen readers will access links on a page via a list of links and thus must be able to discern the purpose of a link when taken out of the context of the surrounding content.

To add a hyperlink to a Microsoft Word document, place your cursor where you want the hyperlink. Then, on the Insert tab, in the Links group, select Hyperlink:

This will open the Hyperlink dialog box:

In the “Text to display” bar, type in the name or phrase that will briefly describe the link destination. In the “Address” bar, type the URL. Click “OK.”

Provide appropriate alternative text

Alternative text provides a textual alternative to non-text content in web pages. It is read by screen readers in place of images allowing the content and function of the image to be accessible to those with visual or certain cognitive disabilities. The key principle is that computers and screen readers cannot analyze an image and determine what the image presents. As content developers, text must be provided to the user which presents the content and function of the image.

To insert a photo into your document, select the Pictures icon in the Illustrations group in the Insert tab:
This will prompt the “Insert Picture” dialog box. Locate the picture you want to include, and then click “Insert.” This will place the selected picture within the body of your document:

Once the picture has been place, you will need to add the alternative text. To do this, right-click on the insert picture to display the photo options and select “Format Picture”:
This will open a “Format Picture” panel on the right side of your screen. In the “Format Picture” panel, select the third “Layout & Properties” icon. Click the ALT TEXT action arrow to display the “Title” and “Description” bars:

The text alternative for a simple image should be typed in the “Description” bar and limited to no more than 120 characters as a rule of thumb, while the alternative text for graphs, tables, and complex images (such as detailed maps and diagrams) should give a brief summary of the included information and follow with contextual description in the body text around or under the complex graphic. If the body of the document already contains a sufficiently detailed description, the alternative text can simply identify the image so that the reader knows when it is being referred to. There are no hard and fast rules for determining what alternative text should say (it depends on the image, its context, the intent of the author, etc.), one simple trick is to imagine describing the image to someone over the phone. The more important an image’s content is, the more descriptive the alternative text should be. If images are purely decorative and contain no informative content, they do not require a description (in this case, type double quotation marks in the “Description” bar).

Unless the image has an identifiable title (The Starry Night, Mona Lisa), leave the “Title” bar blank.

Do not rely on color alone to convey meaning
When color is used to enhance or enliven the visual display of a page, people who cannot access color will not necessarily suffer from reduced usability. They will still be able to access the materials on the site and to operate the site functions. However, when color is an integral part of the user interface, people who cannot access color may encounter difficulties. When color is used to convey information or to provide direction—as an indicator, to draw attention to interface elements or important text, and to provide status information—nonvisual users as well as some
visual users will be affected. Color is an extremely effective method for creating emphasis and providing feedback—two essential aspects of a user interface. The solution is to provide redundant emphasis and feedback using other, accessible methods.

Use headers or formatting elements such as underlines, borders, or other symbols along with color to convey meaning. Printing a color document in black and white is the best test to see if you have lost any meaning. In the example below, the essential information (which assignments are required) is relayed using color only; the information is lost when printed in black and white. The simple addition of the asterisk symbol allows the document to maintain meaning when in black and white.

<table>
<thead>
<tr>
<th>Required Readings in Red</th>
<th>Required Readings in Red</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Chapter 3</td>
</tr>
<tr>
<td>Chapter 8</td>
<td>Chapter 8</td>
</tr>
<tr>
<td>Chapter 9</td>
<td>Chapter 9</td>
</tr>
<tr>
<td><strong>Chapter 15</strong></td>
<td><strong>Chapter 15</strong></td>
</tr>
<tr>
<td>Chapter 21</td>
<td>Chapter 21</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Required Readings in Red (*)</th>
<th>Required Readings in Red (*)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1*</td>
<td>Chapter 1*</td>
</tr>
<tr>
<td>Chapter 2*</td>
<td>Chapter 2*</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Chapter 3</td>
</tr>
<tr>
<td>Chapter 8</td>
<td>Chapter 8</td>
</tr>
<tr>
<td>Chapter 9</td>
<td>Chapter 9</td>
</tr>
<tr>
<td><strong>Chapter 15</strong></td>
<td><strong>Chapter 15</strong></td>
</tr>
<tr>
<td>Chapter 21</td>
<td>Chapter 21</td>
</tr>
</tbody>
</table>

**Universal Design:** Avoiding use of color to convey essential information ensures that the information is accessible to those who can’t reliably discriminate between colors. This group includes people with blindness and color blindness, but it also includes people using monochrome monitors and hand-held computers with green screens. It also benefits people who are using voice web services.
Create accessible data tables
First you need to consider if you can use a list instead of a table in your Word document. Often a list will convey your data in an easier to navigate group than a table. Tables are useful for identifying relationships between data when those relationships are best conveyed with rows and columns. To make data tables accessible to assistive technology users, you will need to clearly identify column and row headers. After you determine your data is best presented in a table, keep the table simple. Complex tables can be difficult for assistive technology users to navigate and understand unless they include markup that identifies the relationships between headers and data cells. An accessible complex table needs to be authored with an HTML editor. Do not split cells, leave cells blank, or use a table for layout.

Tables should not be used for document layout. Word can do this with styles, and formatting—including organizing content into columns.

On the Insert tab, click the “Table” icon:

This will prompt the “Insert Table” dialog box:

Move your cursor across the provided grid to select your desired table size. As you slide your cursor, you will see a table appear and adjust size in the body of your document. Once you have selected the desired table size, click “Insert Table…”:
Once you have inserted your table and populated it with your data, highlight the top row of your data table (which should contain the title of each column), right-click, and select table properties:

This will prompt the “Table Properties” dialog box. In the “Row” tab, CHECK the “Repeat as header row at the top of the page” box and UNCHECK the “Allow row to break across pages” box:
Next, navigate to the “Alt Text Tab” of the same “Table Properties” dialog box. In the “Description” box, provide a brief summary of the data contained in the table. You may leave the “Title” box blank. Then, click OK:
Run Accessibility Checker

Many authoring tools now have "Accessibility Checkers" to help identify areas in a document that need accessible design. Microsoft Word has such a tool to help with the accessible word document creation and remediation process. While this tool will not identify all accessibility issues (links to videos without captioning, etc.), the Microsoft Accessibility Checker will find most issues.

To run the Accessibility checker, select the "File tab":

Select the "Info" tab, the select the "Check for Issues" button:

This will prompt a dropdown menu. Select “Check Accessibility”: 
Upon running the Accessibility Check, a panel will appear on the right side of your screen alerting you to potential accessibility errors:

This panel will reveal (1) what errors you made, (2) why it is important to fix the highlighted errors, and (3) how to fix the highlighted errors.

Click the errors, and then follow the instructions at the bottom of the panel under “Additional Information” to fix errors for increased accessibility.
Updating Old Microsoft Word Documents for Accessibility

You want to make an old document accessible. What are you going to do? If you follow these six simple steps, you will have an accessible document in no time!

**Step 1: Planning**
This step is essential. The more time you invest in planning, the less time you’ll have to spend fixing the document later. Here are some important questions to keep in mind: how will the new accessible version look? Should it look as close to the original as possible, or should you update its appearance? Is it already structured and organized correctly? If not, what changes will you make?

**Step 2: Open Your Old Document**
Open the old document that you want to make accessible. Highlight all of your text, then copy your document by pressing ctrl + c on your keyboard. You may want to keep this document open for reference during Step 5.

**Step 3: Start a New Document**
Open a new blank document. Paste your old document into the new, blank document by right-clicking and selecting the “Keep Text Only” option. This option looks like a clipboard with an upper-case A on its bottom right corner.

This action removes all previous formatting.

**Step 4: Save your New Document**
Save your new document at this phase. If you make an error in the next step, you will be able to revert to this fresh, unformatted version of your original document.
Step 5: Style your Document

Good heading structure helps readers to understand how the document is organized. Assistive technology users can move between headings, which makes navigation usable and more efficient than without headings. Headings and subheadings should be identified as such using the built-in heading features found in the Styles Ribbon. Headings should form an outline of the page.

In this step, apply styles to the unformatted document to give it the look you want and the structure it needs in order to be accessible. Because the new document lacks formatting, you may want to refer to the old document as a guide for determining structure and choosing styles.

Using the Styles Ribbon

In order to apply structure and formatting to your new document, you will utilize the Styles Ribbon. Select the “HOME” tab on the top left corner, then navigate to the Styles Ribbon on the upper right of your screen.

To incorporate structure, you will place your cursor anywhere on the line that you would like to make into a heading. Then, navigate to the Styles Ribbon and select the heading style.

From this:

Notice the setting selected in the Styles Ribbon to the heading “syllabus”
To this:

Notice the new setting selected in the Styles Ribbon to the heading “syllabus”

Once headings and subheadings have been incorporated into your document, you can then adjust the font and font size to your preference.

As you adjust the formatting of your document, periodically save your document by pressing CTRL + S to avoid losing work.

Step Six: Run the Accessibility Checker
Once you have applied structure and formatting to your document, run an Accessibility Check on your document before finalizing it.

Other Resources:
The National Center for Disability and Access to Education has created one-page accessibility resources to assist in creating accessible content. For help creating accessible material to enhance your course, reference the following documents:

NCDAE Microsoft Word 2013 Accessibility Cheatsheet
NCDAE Microsoft Powerpoint 2013 Accessibility Cheatsheet
NCDAE Microsoft Excel 2010/2013 Accessibility Cheatsheet
NCDAE Adobe Acrobat XI Accessibility Cheatsheet
NCDAE YouTube Accessibility Cheatsheet

iii http://teachingcommons.cdl.edu/access/materials/fwis.shtml
iv https://ux.mit.edu/accessibility/laws
v https://ux.mit.edu/accessibility/laws
vi http://www.nscc.edu/resources/web-accessibility-statement//
iii https://www.tbr.edu/sites/tbr.edu/files/media/2015/08/Accessibility%20Task%20Force%20Recs-Final.pdf


ix http://webaim.org/techniques/alttext/

x http://universalusability.com/access_by_design/color/alone.html

xi https://itaccessibility.illinois.edu/word-documents/color

xii http://www.accessibletech.org/access_articles/webinfo/accessibleWebBenefit.php